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Salsal
(Such a Lovely Software for Astronomy)

Practical Session
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-l-éu How te measure Light

s A CCD (Charge Coupled
Device) converts photons in
electrons criating na electric
current.

m CCDs are detectors made our
of silicon. Each element is a
pixel (picture element).
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"'é“ Open the Salsal program [

After completing the installation click on this icon:

@ salsal =) o/X]

File Edit Image Process Analyse Plugins YWindow Help
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* Click on the icon or click on ‘Open’ in the ‘File’ menu
* Choose your image, e.g. the image ‘ sny.fts ":

How to adjust the image
brightness?




File Edit Image Process Analyse Plugins Window Help
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Click on the icon or on
‘Image’ menu of the
toolbar, choose
“Adjust” and
“Brightness/Contrast”
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File Edit JiEEEN Process Analyse Plugins Window Help
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Type

Show Info..
Properties...
Colar
Stacks

ixel Duplicate...

Rename...
Scale...

Lookup Tables

Ctri+
Ctrl+Shift+P

Ctrl+Shift+D

Ctrl+E

Adjust »| Brightness/Contrast...

Color Balance..
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Size...
» Canvas Size...

. 5968.
< I
Minimum
< I I
Maximum

<

Brightness

Contrast




Image brightness

A new window will be displayed

5968.00

.
& = C! g IR
| 400400 pixels; 16 bits Niv. de gris; 312K

Minimum

< I I

Maximum
<

Brighthess

<
Contrast

Reset

Apply

L

click ‘Auto’

| 400x400 pixels; 16 bits Niv. de gris; 312K




Type

Adjust

Show Info... Ctri+l
Properties... Ctrl+Shift+P
Colar

Stacks

Duplicate... Ctri+3hift+D
Rename...
Scale... Ctri+E

Lookup Tahles
o

Grays invert

. Red
Green
Blue
Cyan
Magenta
Yellow

Red/Green
Fire

Ice
Spectrum
3-3-2 RGB

Invert LUT
Apply LUT

Show LUT




Display the Look-Up Table

The Look-Up Table (LUT) represents the relation between color and
intensity of stars.

Select the option ‘Show LUT’ in the ‘Image’ menu.

D Look... Q@@

198x554 pixels; RGB Caol




Change the Look-Up Table

Select the option ‘Lookup Tables’ in the ‘Image’ menu, for example
‘Red’, ‘Green’, ‘Blue’ or multi-color LUT ‘Spectrum’.




File Edit Image Process

(

Plot a segment on the image to get the

corresponding plot profile

Make a profile

PENEER Plugins  Window  Helg
Photormetry
Clear Photometry Results
Photometry Settings

Ctri+hd

Set Scale...

Scale Bar
Calibration Bar The cursor on the

segment displays the

Histogram Ctri+H
actual position on the

Surface Plat... profile.

Tools

£ Plot of snz.fits - 2

520%250 pixels; 8-bit; 126K

£
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>
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Distance (pixels)

List Save | Copy
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About the Display

e Open a moon iImage

 File Edit Image Process A

ex and y are the coordinates of the cursor.

e |[n this example x and y are the coordinates of
the central spike of the biggest crater.

e \alue is the number of counts of the pixel
which coordinates are displayed (brigthness)



e |n Salsal, you can

(e
)

uzoom” the image File Edit Image Process Analyse Plugins Window Help
using the

magn ifying glass N S

tool in the tool bar.

e Just click anywhere o e |l
in the image and it '
zoom in.

eTo “zoom out” hold
down Ctrl key while
clicking on the
image or use the
right side or your
mouse.




Open an
image
and
zoom in

Each square is
a pixel
(picture

element)




s Find a crater as big as your town.
@ Process Analyse Pluging Window Help

Open image

Vieasuring size wWith Images

476x461 pixels; 16-bit greyscale; 46K

Show Info...

Properties... Ctrl+Shift+P
Color 4
Stacks 4

Duplicate... Ctrl+Shift+D
Rename... atahase Image ID
er Name

Scale... Ctr+E  u Email address

LDDlip Tahles [0
MOONDIAM= 3476 km = Moon"s Diameter'
AGE ='8days'

ILLUM = lllumination: 59%"

RA ='06:186"

DEC ='+20:33"

ANGSIZE = '32.8 arcminutes = Moon"s angular size"

SCALE ='.10 km per pixel; 0.68 miles per pixel. Approximately'
CRATERS = 'Ptolemaeus, Alhategnius, Alphonsus, Arzachel'

Finnaly in
< “Analyse”
menu choose
‘measure’

@ Resulis B@B]

File Edit Font

1078.316 499511 1667.667 O 105.333

diameter/2=radius
radius x 1.1km

Area=mradius?



m Select a region in

File Edit Image Process Analyse Plugins Window Help

image “M51.fits”  [EICIREINIS

to obtain the £1Q¥ |§lele| |o >
B

correspondent

518 (25%) (= B[ || B interactive 3D Surface Plot v2.22 (M51.FTS)

(,ll. 51 FTS 5oz
S u rfa Ce p | Ot O r‘ 38x426 pixels; 32-bit, 396K 3 IOriginaI Colors 3 [ z-Ratio = xy-Ratio

Grid Size: 128 Smoothing: 3.0 Perspective: 0.0 Lighting: 0.2 Clinvert Axes

. j j ] ] Text Lines

just measure the
whole image

= Open the
“Analyze” menu

and choose
“Surface plot”
and accept the
default options.

Imagel3l




¢ jup? fits EEX
512x512 pixels; 16 bits Niv. de gris; 512K

< jup? fits CEx ‘
512x512 pixels; 16 bits Niv. de gris; 512K
‘ '

Adjust images with
‘Auto’




‘Process’ menu the option ‘Image Calculator...’, the result will be

created in a new window.
© salsal

< Image Calc...

Translation Image 1: [jup6iits v |
4 s Rotate Operation:  |Add -

Z00m Image 2: [TTRAIE ~ [ﬂ Result of jupé.fits CEX
} 512x512 pixels, 16-bit areyscale; 512K
v Create New Window
Ok | Cancel

Choose the &
images, ’

’ ‘ the operation

and
click ‘OK’

512%512 pixels, 32-hit, TMB




Subtract two images

It is also interesting to subtract them :

¢ Image Calc... [X]

Image 1:  [idaiE; ~ < Result of jupé.fits Q@@
. 512%512 pixels; 16-bit greyscale; 512K
Operation:  |Subtract «
| Image2: |jup7fits v

[V Create New Window

ok cancel




To make a movie open all the images and chose in the Image meriat
option Stacks followed by Images to Stack

File Edit Image Process Analyse Plugins Window Help

Open all Jupiter files

a‘-’i

512x512 pixels, 32-hit; 1MB

© jup9.fts (50%)
512x%512 pixels; 32-hit, 1MB




Make a movie

Fjle Edit BUEeEN Process Analyse Plugins Window Help Convert images to stack. Adjust
\ Type brightness and contrast to be able to
Adjust see the Moons

E Show Info... Ctri+l
Properties... Ctrl+Shift+P

Color
| Add Sice
512612pke Duplicate...  Cti+ShitsD | o or =10

MNext Slice
Previous Slice
et Slice...
Make Montage...

Rename...
Scale... Ctri+E

Lookup Tables 4

Images to Stack

stack to Images

start Animation
. | 6 gl
|ldentify the image that doesn't

belong to the sequence
Manually scroll to see the

animation. Or Start

You can save the stack as and .avi file e T
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) Ssalsal
File Edit BlgEBEN Process Analyse Pluginsg Window Help

E‘) E Type »

Adjust 4 +
4 I: Show Infa... Ctri+ || &
Properties... Ctrl+shift+P
Color »

7, Stack (5 y
B upl); 51 Duplicate..  Ctri+Shift+D | i

Next Slice
Previous Slice
et Slice...
Make Montage...

Rename...
Scale... Ctrl+E

Lookup Tables 4

Images to Stack

Stack to Images

Start Animation

"? Stop Animation

Animation Options...

Teacher Training Prog

Delete a slice

Manually position in the slice you
want to delete



Change the Speed

File Edit JgEREN Process Analyse Pluging Window Help

Adjust AT
4 E Show Info... ctri+l || @

Properties... Ctrl+Shift+P
Color >

15 QupS). Duplicate..  Chr+ShiftsD | oo oCE
Next Slice

Rename...
Scale. .. Ctrl+E Previous Slice
Set Slice...

Make Montage...
’ Images to Stack
Stack to lmages

start Animation

Lookup Tahles >

stop Animation

Animation Options...
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s Open M27

blue, green
and red
Images.
Remember to
adjust
brightness and
contrast

| File Edit Image Process Analyse Plugins Window Help

1512x512 pixels; 32-bit; 1MB

- 512%512 pixels; 32-hit; 1MB

'512x512 pixels; 32-hit; 1MB

-3l € Brightness & Contrast

< | I >

Minimum

< I I

Maximum

Brightness

Caontrast

7677.77



= After zooming each image to the maximum, verify the
coordinates of the pixel with higher counts (value) and use the
function ‘translation” in “Process” menu to correct the shift...if
needed ... you will not need it in this example.

- g 4 Translaton ¢ : k ;
5120512 pixels, 16-bit greyscale, 512K 51 23512 pieels; 16-bit greyscale; 512K 5123512 pueels, 16-bit greyscale, 512K




to 8-bit.

D salsal
File Edit MgEBEN Process Analyse Plugins Window Help

Adjust | 160k

4 C Show Info... Ctriel | 24P
. . RGE Colour

Properties... Ctrl+Shift+P

Color »
: Stacks 3
12%512 pixel  Duplicate... Ctri+Shift+D  2x512 pixels; 8-hit, 256K
[ v Rename... '

Scale... Ctrl+E

Lookup Tables 4

' E'-"‘:‘ " '- ; bk . < .#_- =

E)0X]

251 2 pixels; 8-hit; 256K

BEE




= Build a color image using ‘RGB Merge™ of ‘color” in “Image” menu.

o

@ salsaJ
File Edit BlitzBEN Process Analyse Plugins Window Help

»

Adjust -
( C Shaw Info... ctri+ || @ ®

Properties... Ctri+Shift+P

Stacks *  RGB Split

() RGB (bl
512612 piel  Duplicate..  Ctri+Shift+D | DMl

Color Picker

Rename...
Scale... Ctrl+E

Lookup Tahles >




s On the displayed box choose the correspondent image and
remember to check the option ‘keep source stacks'.

(4
)

File Edit Image Process Analyse Plugins Window Help

Red: |M 27-001-Red.fts v
Green: |M 27-001-Greenfts

Blue: M 27-001-Bluefts




Color Images with Salsal

s Usually the
filter is not part
of the name of
the image. To

find this check
the image info.

Att.: Jpeg images
don’t have this
type of info
associated to it.
This is a FITS
feature

@ salsaJ
File Edit MlgEBEN Process Analyse Plugins Window Help

E‘J E Type ’

— Adjust vl

/ | e ¢

Properties... Ctrl+Shift+P
Color
Stacks

3 M 27-00 Info for M 27-001-Green fte
h12x512 pixe  Duplicate. . Ctrl+Shift+D  jle Edit Font
I B Rcname...
Scale... Ctri+g  plect M 27
2lescope: LX-200 10" 6.3
’ strument: ST-9
2 Filter: Green
: 3‘ 3 8 | Observer: Frank Pino Ironwood North Observatory
y ‘ A B Exposure time: 360.0s
. E3s Date of observation: 2006-05-13T11:17:48
|l | Universal Time: 11:17:48
Right Ascension: 19 59 36.00
§ | Declination: 42243 01.0

Lookup Tables

SIMPLE =

BITPIX = 16 /8 unsigned int, 16 & 32 int, -32 & -64 real
NAXIS = 2 /number of axes

NAXIST = 512 /fastest changing axis

NAXISZ = 512 /next to fastest changing axis

BSCALE = 1.0000000000000000 /physical = BZERO + BSCALE”Zv

< >

FITS or Flexible Image Transport System is a digital file format used to store, transmit,

and manipulate images.



color images with Salsal

s [f the result is good save the image.

@ salsaJ

Mew
Open Ctrl+0
Open Recent

Close Ctri+wy
Save Ctrl+5
Save As
Revert Ctri+R

Page Setup...
Print... Ctrl+P

Quit Ctri+Q

Image Sequence...
AV
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s Open the ZetaOph images W2, W3iand W4
fromWISE telescope one by one and change
the type to 8 bit to reduce the size if needed

O salsaJ
File Edit BlgEEEN Process Analyse Plugins Window Help

EE Tom—
o | I T
Adjust p| 15°BE

v 32-hit
4 E Show Info... Ctri+

Properties . Ctri+shiftsp | o0 ColoUr
Color

® 2499m1. Stacks

4095:40950  yolicate . Ctrl+Shift+D

Rename...
l Scale.. Ctri+E

Lookup Tables




Make your color image

File Edit Image Process Analyse Plugins Window Help

»Ee BO
Z LAY 16%35)| ®

@ rRGB Merge

Red: '2492m107_aal1-wd-int-3.fits

mjip.
15%4095 pixels, 8-hit, 16MBE  Green: | 2492m107_aal1-w3-int-3.fits « BD

4095 pixels: 8-hit 16ME |

=N 2 492m 107 _aal1-w2-int-3.fits 82

[ Keep source images

Okl Cancel |
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File Edit Image Process Analyse Plugins ‘Window Help

4095%4095 pixels; RGE Colour ; 64MB

Minimum
< I | >
Maximum

Brightness

Contrast




Lookin: || Sundall v ?
A

@_1 spots_versus_temperature_pressure, x|

Os meus
documentos
recentes

Ambiente de
trabalho

Os meus
documentos

O meu
computador

Os meus locais
na rede

|0) Actividades resolvidas_por
|2) sun_nov_99

[_E_'I 11year_cycle.xls

E-'i] Actividade4-negativos.ppt
£ actividade4-positivos.ppt
. Guidebook-website version.pdf
™ Sol_020110_K1V.jpg

™ Sol_K1V_011227.jpg

[&] sol_k1v_s21121.jpg

[&] sol_k1v_s21122.jpg

[&] sol_k1v_921123.jpg

e Sol_K1v_921124.jpg

@_] solar_rotation.xls
@_] spots_count.xls

<

Files of type: | all Files

I — N <
Filename:  |921122.jpg" "Sol_K1¥_921123.pg" "Sol_K1¥_921124.jpg"

—

' sun.mdy

E_ﬂjsun 4_all_Rosa.ppt

) Traducao Anexo 4_Actividades com o S

v | Cancel




File Edit Image Process Analyse Plugins Window Help

EeEO
£ O¥

ww O Sol K1v_921124.jpg (5...

UX5UU pixels, Sbl'f 2441500x500 pixels, 8-hit, 244K 250200 nixels: & blt 24 500x500 pixels; 8-bit; 244K



Viaking a movie

s [nvert the color of the images

@ salsa) A=_3F

File Edit QbR Process Analyse Plugins Window Help

Type
Adjust
Show Info... Ctri+l
Properties... Ctri+Shift+P
Color

D0S00 pixels 1y e ate Ctrl+Shift+D  B00x500 pixels; 8-bit (inv
Rename...
scale... Ctri+E

Lookup Tables

Grays invert

Red
Green
Blue

Cyan

Magenta




Type
Adjust

. Show Info...

00500 pixels

Properties...
Color
Stacks

Duplicate. ..
Rename. ..
Scale...

Lookup Tahles

Analyse Plugins Window Help

Ctri+
Ctrl+Shift+P

Ctri+Shift+D 5

Ctri+E

Grays invert

Red
Green
Blue
Cyan
Magenta
Yellow

Red/Green
Fire

Ice
Spectrum
3-3-2 RGB

Invert LUT
Apply LUT

Show LUT
Edit LUT...

m Other alternative to invert
the color

&\ LUT Editor (X




Viaking a movie

m Stack -> Convert images to Stack

File Edit Qly=BEN Process Analyse Plugins Window Help

| [= Type — =
5 @ stack (50%) M=1E3

Adjust 114 (S0l_K1¥_921121); 500x500 pixels &-bit (in

4 I: Show Info... Ctri+ ©

Properties... Ctri+Shift+P

Color >

Duplicate..  Ctrl+Shiftsp | Doiete Slice

Rename. ..
Scale... Ctri+E

Next Slice
Previous Slice
Set Slice...

Make Montage...

Lookup Tahles »

Images to Stack
Stack to Images

Start Animation




Viaking a movie

Change the animation options if needed

© salsal

File Edit MigEEEN Process Analyse Pluging wWindow

E“J E Type

Adjust

[ 4 Showlinfa... Ctri+l
Properties... Ctrl+Shift+P
Color

Duplicate... Ctrl+Shift+D
Rename...
Scale... Ctrl+E

Lookup Tahles

Add Slice

Delete Slice
Mext Slice
Previous Slice
Set Slice...

Make Montage...

Images to Stack

Stack to Images

Start Animation
Stop Animation
Animation Options. ..




@ salsaJ
File Edit flGEREN Process Analyse Pluging Window Help

E‘J E Type

Adjust
( .+ Showlinfo... Ctrl+l

Properties... Ctri+Shift+P

Duplicate... Ctrl+5hift+D
Rename...
Scale... Ctri+E

Lookup Tahles

Add Slice

Delete Slice
Next Slice
Previous Slice
Set Slice...
Make Montage...

Images to Stack
Stack to Images

Start Animation

Stop Animation
Animation Options. ..

Teacher Training Prog

€ Animation Options @

Speed (0.1-100 fps):
First Frame:

Last Frame: [4 ]

| Loop Back and Forth
v Start Animation

ﬂl Cancel |

Change the animation to 1 frame/seg and start
animation



File Edit Image Process Analyse Plugins Window Help

wE e B0




Measure the size of the solar disk in pixels

0 Halpha_4_1 2_2001 ]pg (75%) @




© Halpha_4_12_2001.jpg (600%) [=13R Zoom in to measure the spot in pixels

500x500 pixels; 8-hit {inverting LUT); 244K

f
=
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COUNITN
S1VNSIHOARS
WITHPLOT PROFILE

Plugins Window Help
Photometry

Clear Photometry Results

Photometry Settings 3 ‘ ‘

Measure... Ctri+h

Set Scale...
Scale Bar

3 20111130 0000 hmiig

12x512 pixels; RGE Colour | 1ME Calibration Bar

Histogram Ctrl+H

L] Plot Profile Ctri+K

Surface Plot...
Tools
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File Edit Image Process Analyse Plugins Window Help

wEe O
Z LAWY oo ®
o

Plot of 20111125_0000_hmiigr_512

Distance (pixels)

SetScale Profile Plot Options




S1VNSIHOARS

( Photometry

Photometry Settings

Measure...

Set Scale...

scale Bar

512%512 pixels; RGE Colour ; 1MEBE Calibration Bar

[]

Histogram
Plot Profile

Clear Photometry Results

WITH SURFACE PLOT

Ctri+H
Ctri+K

surface Plot...

Tools

>




File Edit Image Process Analyse Plugins window Help

W E e O
,DQY 8o

Abort Macro or Plugin {or press Esc key)

z-Ratio: 1.0

LJ

Manc: 100 %
LJ

Min: 0%

Imagel30




File Edit Image Process RAGELEEN Plugins Window Help

E‘) E = ( Photometry

Clear Photometry Results

/ Q w Photometry Settings
+

Measure... Ctrl+hd

Set Scale...

Histogram
Plot Profile
Surface Plot...
Tools

In this case the value is
approx. 8 pixels

SIS Zoom in to
measure the spot
in pixels.

Select the straight line and
draw it across the spot.

Then Select : Analyse and
Measure from the menu.



Vieasuring the diameter

of the Sun

' satsa) AEE)

File Edit Image Process RAGELEEN Plugins Window Help

E‘] E = ( Photormetry

Clear Photometry Results

/ Q w Photometry Settings
g

Measure... Ctri+h

Set Scale...
‘.| Scale Bar

Histogram Ctrl+H
Plot Profile Ctri+K
Surface Plot...

Tools

In this case the value is
approx. 486 pixels

Select the straight line and
draw it across the Sun.

Then Select : Analyse and
Measure from the menu.



- Photometry

The photometry tool enables to measure the brightness of stars.
File Edit lmage Process Analyse Plugins YWindow Help

< snz.fits |
400x400 pixels; 16-bit greyscale; 312K lindex_[image [slice [x [y [intensity [radius [sky | af
L 5 e fi |

shzfits - 94 90 20899.07 6 340.81

ephotometry
File Edit Font

idex[image X[V [Sars it Ngrs adis |

Click on the
e object you
Y o ——_Wwant tO
5 . measure.
With the right The result
button of your appears in the
mouse choose the second
¢ circle window.




Oval selection

Star Radius : [ Forced Star Raduis

Sky (¢ auto  { Forced Sky Radius

" Forced Sky Value




I\/Ieasureing the size of a sunspotlj

s Knowing that the sun has a diameter of approx. 690
000 km you can calculate the size of the spot. In this
case

m Solar disk ~ 690.000 km <-- > 400,39 pixels
m Sunspot X <--> 5 pixels

m Sunspot size ~ 8 616 km



